
 

 

  Pocket 3D v15.5.3 
Patch release 

 

 
Updates… 
 

 

Pocket 3D v15.5.3, with improved functionalities, is now available for Windows 

and Android devices on myTopcon NOW!. iOS version is available in the 

AppStore. 

 

New features and improvements: 

 

• iOS: Hybrid machine setup available 

• iOS: import DWG/DXF supported 

• New pairing routine for GR-i3 with 3.1.3 firmware 

• Improved mmGPS usage with Hiper XR 

• TILT disabled for control points measurements 

• Base station control points not displayed before valid localization 

• Grade indicator improvements 

• Several important bugfixes, as compare surfaces 

 

 

Supported devices 
 

Windows (v15.5.3) 

• FC-5000 / SHC-5000 

• FC-6000 / SHC-6000 

• FC-6400 / SHC-6400 

• FT-100 

• Windows PC, tablets, … 

 

Android 8 or higher (v15.5.3) 

• FC-6000A 

• FC-700 / SHC-700 

• GX-10W 

• Juniper CT8x2  

• Phones/tablets 

 

iOS 14 or higher (v15.5.3) 

• Phones/tablets 
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Overview 

Pocket 3D v15.5.3 is a new version of our long-ranging Pocket 3D software application. It’s an 

aftermarket range pole system utilizing Topcon’s & Sokkia’s GNSS, LPS & Hybrid solutions. This 

version of Pocket 3D can be run on any Windows, Android and iOS platform.  

Pocket 3D for Android on the CT8x2 or GX-10W is an integral part of Topcon’s MC-Mobile solution 

and works closely together with MC-Mobile Excavator and MC-Mobile CTL. It’s also called MC-

Mobile Pocket 3D. This release of Pocket 3D supports all LPS, GNSS and mmGPS options. It’s also 

offering the advantage of working with the cloud-based Sitelink2 solution.  

The release notes gather all the important information that was found during validation and 

verification testing. Some of the new features are explained and introduced in the release document 

with some helpful tips and tricks.  

This patch release contains especially bugfixes and improvements. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



Latest recommended SW and FW 

 

Even though Pocket 3D supports all SW and FW versions, we recommend using the latest versions as 

of now: 

• SW_MC-MOBILE_RVR_AM_v15.5.3.203_ANDROID.apk for Android 

• SW_POCKET-3D_RVR_AM_v15.5.3.103_WINDOWS.zip for Windows 

• SW_POCKET-3D_RVR_AM_v15.5.3_iOS for iOS from the AppStore 

 

• GR-i3: FW 3.3.1 & GNSS FW 5.5.2 

• Hiper XR/Sokkia GRX5: GNSS FW 7.1 

• General GNSS FW 5.7 

• LN-160: Optical Firmware - LN-160 VERSION 16 

• LN-150: Optical Firmware - LN-150 VERSION 16 

• LN-100: Optical Firmware – LN-100 VERSION 1.08 

• GT 1200: Optical Firmware – GT-600/1200 Series VERSION 16 

• GT 1000: Optical Firmware - GT-500/1000 Series VERSION 2-1.03EN_01 

• GT 700/1500: Optical Firmware - GT-700/1500 Series VERSION 6 

• PS-100: Optical Firmware - 1.28EN_10 

• PS-200: Optical Firmware – PS-200 Series VERSION 3 

 

 

 

 

 

 

  



New Features 

Hybrid machine setup available for iOS 

The hybrid machine file can now be created in Pocket3D v15.5.3 in iOS devices. 

Import DWG/DXF files supported for iOS 

Pocket3D v15.5.3 on iOS now supports the import of DWG/DXF files. 

New pairing routine for GR-i3 using 3.1.3 firmware 

The pairing routine for GR-i3 receivers running on controller firmware 

version 3.1.3 has been improved, to match RED compliance (cyber 

security). The display and GNSS receiver need to be within 1m of each 

other during the first pairing attempt. It may take several minutes before 

the Android pairing request appears. 

 

Improvements 

mmGPS usage with Hiper XR 

The usage of mmGPS with Hiper XR has been improved. 

TILT disabled for control points measurement 

Users are notified that TILT is disabled while measuring a control point 

with a TILT-enabled GNSS rover. If the tilt is too high, a message also 

prompts them to hold the pole upright. Previously, TILT had to be turned 

off manually before control-point measurement. 

Base station control points not displayed before valid localization 

When a base station is started over an unknown point, its control point will not be displayed on the 

map until a valid localization has been performed. This prevents showing an inaccurate position prior 

to localization. 

Grade indicator 

The “on-grade” range of the grade indicator has been modified to match better jobsite accuracy 
expectations. 

  



Radio settings stored 

Radio settings are now preserved when switching between different radio types within the same 

machine setup. For example, Pocket3D will retain the original NTRIP credentials entered for a  

HiPer XR even after switching to the internal radio and then back to NTRIP. 

Spanish language 

The Spanish language file has been updated and improved. 

Project details: Deflection and Rotation now use configured display units 

Pocket3D v15.5.3 now displays localization parameter values in the Project Details dialog according 

to the selected display units. Previously, these values were always shown in DMS: 

• Deflection is now shown using the grades display units, allowing users to view the value in 

percentages when applicable. 

• Rotation is now shown using the angle display units. 

 

Bugfixes 

Compare 2 surfaces 

In some cases, the result of compare of 2 surfaces was incorrect. This issue has been resolved. 

OSM background map 

Issue resolved related to OSM background map not loading 

anymore in 15.x software.  

NOTE: “API key required” watermark on map is normal 
behaviour for this software build. 

Cut sheet report error 

Issue resolved related to cut/fill values in cut sheet report when performing stake out of alignment 

with surface elevation. 

Elevate polyline result 

Issue resolved related to elevate polyline results not being saved when closing and restarting the 

application. 

Import txt file 

Issue resolved related to import of txt file with space delimiter, where the import didn’t succeed. 



Segment – create offset polyline 

Resolved an issue where the direction arrows in the Offset 

Polyline dialog were not visible when offsetting a single 

polyline segment, making it unclear whether the offset would 

occur to the left, right, or both sides.  

Working surface display settings - Plane 

Fixed an issue where the Plane display settings (Show Grid Lines, Grid Interval and color) were not 

being applied correctly. 

General Info, Defects and Known Issues 

List of general information relating to general changes, known issues and/or items not supported in 

Pocket 3D v15.5.  

• Pocket 3D v 15.5 only supports serial connection to Hiper XR and Sokkia GRX5 for external 

radio usage. If the user wants to connect the field controller over serial connection to the 

GNSS receiver, he should use a DB9 RS-232 serial cable. A USB-C to USB-C cable will not work 

as serial connection. 

• Pocket 3D v 15.5 only supports the usage of a total station (GT and PS series) set with 

distance units meters and US survey feet on the total station. When the distance units are 

set to International feet, errors may occur. 

• After starting up a Base Station, by default the last used settings (Antenna type, radio 

settings, etc) are stored. Next time the user wants to start up a different base, he should 

reconfigure those settings again (matching the new base station). Use the < Discover > 

button to find the new Bluetooth device in the device list to connect to the device. 

• Pocket 3D v 15.5 only supports the import of metric CAD files (.dwg or .dxf) in meters. 

Importing CAD files in millimeters or centimeters will result in scaling issues. 

• To import and export files on the GX-10W and FC-700, the user should use the folder 

Internal Storage > Download when selecting the folder “Downloads” as file location in 

Pocket 3D. 

• Bluetooth connection between “older” Total Stations and GX-10W using Pocket 3D may lag. 

We see delay in the distance & angle values and coordinates update. Known delay issues 

appear with Total Stations running the “older” Bluetooth module WT-41.  

Affected devices:  

o LN-150 with SN LW008099 and earlier 

o All GT-500/1000 

o GT-600/1200 with SN starting with XQ 



• Connecting to Hiper XR or Sokkia GRX5 over Wi-Fi, the checkbox “Use authentication” 
should always be unticked, as by default configured in a new machine file created in 15.5. 

This issue is related to a GNSS FW issue. 

• Isolate surface has some issues in 15.5 in some specific situations. 

• On Windows when installing Pocket 3D V15.5 it will upgrade the remote support client too. 

The customer will be asked to agree to the install, shutting down remote support client and 

potentially restarting the device. Please agree to all those prompts. 

• After a fresh install, the splash screen will stay up much longer than normal. This only 

happens once, as Pocket 3D needs to move specific files in the background. 

• WM6 is no longer supported. 

• Sitelink v1 is not supported. 

• USB on Android needs to be browsed to before usage in Pocket 3D. 

• When hard resetting your Android device, you will lose all your apps but also your oaf file, as 

the device id might change.  

• Removed the way to switch cross section on/off inside Display options -> Layout tab. This is 

now moved to the “View Area” tab in the same dialog. It is now setup like in 3DMC. The user 
can define its own cross section view, full screen or half screen and can switch between 

different views via the Next state toggle button inside the shortcut bar. 

• To use the Built-in GNSS of the phone/tablet/controller, select machine file “Built-In GPS”. 
NOTE: You will not achieve a fixed solution with that type of GNSS. 

• When connecting to a GNSS receiver, there are 3 type of potential error codes: Txxx – for 

timeout, Rxxx – for rejected and Exxx – for Error. The xxx stands for the ID of Gril command 

that has failed. E.g., T002 – stands for your 2. Command has timed out, which means, you 

don’t have a valid connection to the receiver. 

• Surface/Device data settings are set to default (shown as default green color in section 

view) if the machine is connected to the SL site after the data sync. 

• Empty layers will not be able to be synced to sitelink. If you have an empty layer inside your 

site, the data sync icon might always 

show “Device data has changed”. 

• General versus per Layer settings:  

Operator can set his personalised 

preferences for each layer starting 

with the point symbol , color and 

display properties (point name, 

description and elevation). These 



settings can be personalized for every layer: Data -> Layers -> Edit 

 

The operator can set the 

overall/general display settings under 

View -> Display Options -> Points…, 
without going into each layer 

separately.  

General point display settings will 

respect the layer settings, and will 

display only what is enabled. 

 

• Pocket 3D on CT8x2: use F1/ F2 key as Enter/ESC button inside Pocket 3D. 

Pocket 3D on Android: Go to Settings -> Keypad -> 

advanced to use arrow buttons inside Pocket 3D 

e.g. for rotating total station. 

• All LN-150 units that have the LPS/MC OAF, can 

easily be identified with the label. If you connect 

to a LN150 without LPS/MC oaf, or an LN-100, 

Pocket 3D will show you a message after station 

setup, notifying you, that this station setup can 

only be used with Pocket 3D and not for the 

machine. 

• The iOS version can’t be used to calibrate a 
mmGPS laser transmitter, nor to 

download/upload calibration data of the laser 

transmitter, due to missing BLE module in the 

transmitters. 

• Landscape mode is not supported on small devices. 

• FC-600 doesn’t support GPSlock using TS only due to no available internal GNSS.  

Although, GPSlock is available for hybrid machines. 

 



 

LN-150 does not have an on-board display to check the activated options. 

Once P3D gets connected to the LN-150, the LPS/MC options and firmware 

version can be checked via the TS status dialog and the station setup routine 

 

 

P3D cannot be used with GRi3F, as this unit does not have any batteries at 

all, and has to remain on the mast of a machine to get powered on. 

  

 

 

 

 

When using the P3D and 3D-MC software applications in the MC-Mobile 

workflow with the same NTRIP account, it may take some time to obtain a 

fixed solution when switching between the two applications. This is because 

some NTRIP accounts or casters may still be holding the account open from a 

previous connection, even if the device has stopped using it. This can result in 

a delay of up to 5 minutes before the NTRIP caster frees up the account. It's 

important to be aware of this potential delay and consider using separate 

NTRIP accounts or casters for each software application to avoid conflicts.  

 

 

 

When switching between P3D and 3D-MC software applications in the MC-

Mobile workflow, we recommend disconnecting and shut down the software 

before swapping the GRi3 antenna. It may take some time for the GRi3 to 

swap between CAN and BT connection.  

 


